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Chapter 3
Assembling Project Files

In this chapter you learn about file linking and importing. You learn how to create 
new presets and to modify them as required. You also learn to incorporate objects 
or other scene files into the current scene by externally referencing them.

This chapter contains the following topics:

• Data Linking and Importing

• Linking Files

• References
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3.1 Data Linking and Importing

While the Autodesk® 3ds Max® Design software has a robust 2D 
and 3D modeling system, many users find it most efficient to link 
or import some or all of their design data from other applications. 
This is especially the case if the bulk of the design work is 

completed in other Autodesk software, such as AutoCAD®, 

Autodesk® Revit® Architecture, AutoCAD® Architecture, or 

Autodesk® Inventor®. Sometimes this linked or imported data is 
complete before it is brought into the Autodesk 3ds Max Design 
software, while in other cases simplified data is brought in as a 
starting point and additional modeling is required.

Linking vs.
Importing

In the Autodesk 3ds Max Design 2014 software, files can be 
either linked or imported using the File Link and Import tools. 
The files that can be linked are: .DWG, .DXF, .FBX, and .RVT. A 
large variety of file types can be imported into the Autodesk 3ds 

Max 2015 software including Autodesk® Inventor® files (.IPT, 

.IAM), Autodesk® Alias® .Wire files and the Autodesk® 

Showcase® .APF (Autodesk Packet File), LandXML and DEM 
data files, and Adobe Illustrator (.AI) files. 

The difference between linked and imported geometry is that 
linked geometry remains connected to the source file. If the 
source file is edited, the Autodesk 3ds Max Design Scene can be 
updated to show those changes, similar to how changes to an 
AutoCAD XREF can be reloaded. Imported geometry maintains 
no connection to the source file. 

Autodesk Certification Topics & Objectives
Pro. User

Data Management/Interoperability

• Differentiate common file types and usages

• Use the import feature to import model data

Learning Objectives

• Understand the difference between File Linking and File 
Importing in the Autodesk 3ds Max Design software.

• Understand how to edit the linked data files.
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• If a source .DWG, .DXF, .FBX, or .RVT file is likely to change 
(or you would prefer to make changes in the .DWG, .DXF, 
.FBX, or .RVT directly), then File Linking might be the best 
way to incorporate this data into the Autodesk 3ds Max 
Design software.

• Importing might be faster than linking when bringing a lot of 
data into the Autodesk 3ds Max Design software. Complex 
geometry, such as 3D faces from large Land Desktop terrain 
models, might be faster to re-import (especially through 
LandXML) than to update through a file link.

• File links and imports are launched by clicking (as shown in 

Figure 3–1): expand , expand Import, and select Link 

Revit/Link FBX/Link AutoCAD or expand , expand 
Import, and select Import.

Figure 3–1
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Editing Linked
Data

• Linked geometry can be edited but not directly deleted from a 
scene file. Alternatively, the layer on which the objects are 
placed might be ignored during a reload or set to Hide in the 
Layer dialog box.

• Edits applied to linked geometry (such as through modifiers) 
are automatically re-applied after a link is updated. Some 
complex modifications might not apply as expected, however, 
if the source geometry is changed dramatically be sure to 
verify. You should always review your geometry carefully after 
a link is updated.

• Links to drawing files are not bi-directional, so that changes 
you might make to the data in the Autodesk 3ds Max Design 
software do not update the original .DWG, .FBX, .DXF, or 
.RVT file.

• Linked files can also be bound, where the geometry stays in 
the scene file as-is but the connection to the source file is 
dropped.

Importing • To import a .DWG from the Autodesk Revit software, it is 
recommended to export from the Autodesk Revit software 
using the Export as ACIS solids option. This will also create 
a better geometry than the other option (polymesh). Also it’s 
not obvious, but you must have a 3D View active to export to 
DWG.

• The FBX importer is an independent plug-in that is frequently 
updated. There is a Web Update button in the FBX Import 
dialog box. Using this button, you can check for web updates, 
download the latest updates, and install those. Close 3ds 
Max when you do the install.

Merging
Autodesk 3ds

Max Design
Scene Files

Objects already saved in Autodesk 3ds Max Design scenes 
(.MAX files) are imported into the current scene using the Merge 

option ( >Import>Merge) and not the Import option. 
Merging files is a one-directional transfer that does not maintain 
any connection between the two files. Using the Merge option, 
you can either load only a few objects from a scene or you can 
load a complete scene into the current one.
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Practice 3a Ground Surfaces using Civil 
View

Estimated time for 
completion: 20 minutes

In this practice you will open a .VSP3D file for importing ground 
surfaces. Civil View is available only in the Autodesk 3ds Max 
Design software. If you are using the Autodesk 3ds Max software 
skip this practice. 

You must set the paths to locate the External files and Xrefs 
used in the practice. If you have not done this already, return to 
the Introduction to Autodesk 3ds Max Design chapter and 
complete Task 1 to Task 3 of the Organizing Folders and 
Working with the Interface practice. You only have to set the 
user paths once.

Task 1 - Initialize Civil View.

It is recommended that you import 3D ground surfaces from 
Civil/Survey products, such as AutoCAD Civil 3D or Land 
Desktop using the vsp3d data format. The import process 
involves using Civil View in Autodesk 3ds Max Design.

You only have to 
initialize Civil View once.

1. In the Menu bar, select Civil View>Initialize Civil View to 
initialize Civil View. If you have already initialized Civil View, 
go to Step 5.

2. In the Initialize Autodesk Civil View dialog box, set the 
System Unit to Feet because the civil project that you will be 
opening uses Feet as its unit of measurement. Verify that 
Don’t warn me about System Units again is selected.

3. In the Select a Country Resource Kit area, select US 
IMPERIAL and verify that Start Mode for Civil View is set to 

Manual. Click . In the Information dialog box, click 

.

4. Exit and then restart the Autodesk 3ds Max Design software.

5. Start Civil View by selecting Civil View>Start Civil View.

Learning Objective

• Open a Civil3D data file in a scene file using Civil View.
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6. Open Civil Base XRef.max from your Class Files\scenes 
folder. If a dialog box opens prompting you that there is a 

Mismatch, click  to accept the default values. If 

prompted, click  to accept the file’s Unit Scale. This is 
an empty max file in which the System Unit Scale has been 
set to 1 Unit=1.0 Feet.

7. In the Menu bar, select Civil View>Geometry Import>Civil 
3D (VSP 3D) File, as shown in Figure 3–3.

Figure 3–3

8. In the Civil 3D Import Panel dialog box, click . 
In the Select a VSP3D File dialog box, browse to your Class 
files\Import folder (if required) and open Civil 
surfaces.vsp3d file.

Hint: Starting Civil View

Once you have initialized Civil View, the next time you launch 
the Autodesk 3ds Max Design software, you need to start Civil 
View because Start Mode for Civil View is set as Manual. You 
can change this setting later and set it so that Civil View starts 
when you launch the Autodesk 3ds Max Design software. In the 
Civil View Preferences dialog box, in the General tab, select 
Automatically start Civil View? as shown in Figure 3–2.

Figure 3–2



Autodesk 3ds Max Design 2015 Fundamentals

3–8 © 2014, ASCENT - Center for Technical Knowledge®

The objects listed 
include surfaces, site/
grading featurelines, 
corridor (surfaces, 
baselines, featurelines 
etc.),and point groups, 
etc.

9. In the Civil 3D Import Panel dialog box, a list of objects that 
are in the AutoCAD Civil 3D file are listed. In the left pane, 
select Surfaces [9] to display all of the surfaces in the right 
pane. Select Building Pad, hold down <Shift>, and select 
Parking Lot Surface to highlight the first seven surfaces. 
Select the checkbox for Building Pad to select all seven 
highlighted surfaces, as shown in Figure 3–4. You can select 
them individually as well.

Figure 3–4

10.You will select the corridor surfaces and the baseline. In the 
left pane, select Corridors [1] and in the right pane, select 
PrimaryAccess, Region(1), Region(2), and Region(3), as 
shown in Figure 3–5.

Figure 3–5

11. Click . In the Civil View Information, click 

 to accept the global shift values. 

12.You did not select any feature interpretation. Click  
to proceed without a feature interpretation style.
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13. In the Warning dialog box, click . In the Error dialog 

box, click .

It takes a few minutes to 
load the file.

14.The ground surfaces, building pad, corridor, and parking lot 

are displayed in all of the viewports. If not, click  (Zoom 
Extents All). Note that only the corridor displays the surface 
material and that the rest of the surfaces display a 
checkerboard material.

15. In the Menu bar, select Civil View>Civil View>Civil View 
Explorer to open the Civil & View Explorer. Dock it along the 
left side of the screen by right-clicking on the title bar and 
selecting Dock>Left.

16.Verify that the Civil Explorer tab is open. Expand Civil View 
Objects>Imported Objects, if not already expanded. Select 
Surfaces and note that the corridor is selected in the 
viewports, and the Object List rollout opens. In the Object List 
rollout, note that all of the surfaces are listed, as shown in 
Figure 3–6.

Figure 3–6

A material is not 
required for the first 
three corridor regions.

17. In the Object List rollout, select C3Dsurface-C-TOPO-
Building Pad. In the Surface Parameters rollout, select the 
Statistics tab and note that in the Face Selection Sets, in By 
Material ID, [31] Ground Type 4 has been assigned, as 
shown in Figure 3–8.

Figure 3–7
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The complete list might 
not be visible in the 
Explorer. Hover the 
cursor in empty space in 
the information area 
until it displays as a 
hand cursor. Grab and 
slide the Explorer panel 
up or down to display all 
of the information.

18.Right-click on [31] Ground Type 4 and select Modify Material 
ID Assignment, as shown in Figure 3–8.

Figure 3–8

19.Click  in the Warning dialog box.

20. In the Modify material channel dialog box, select [22] 

Concrete Type 1 as shown in Figure 3–9. Click . 

Figure 3–9

21. In the Perspective viewport, use Zoom and Pan to zoom into 
the building pad. Note how the new material is applied. 

22. If required, select Surfaces again and in the Object List 
rollout, select C3Dsurface-C-TOPO-Existing Ground. In the 
Surface Parameters rollout, select the Statistics tab, 
right-click on [31] Ground Type 4, and select Modify Material 

ID Assignment. In the Warning dialog box, click . 

23. In the Modify material channel dialog box, select [28] Ground 

Type 3 and click . In the Perspective viewport, note 
that the new ground type material is applied to the ground 
surface.
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24.Similarly, for the other surfaces, apply the material types as 
follows. A material is not required for the first three corridor 
regions.

• C3Dsurface-C-TOPO-Inside Curbing: [38] Concrete 
Type 3

• C3Dsurface-C-TOPO-Inside Grading: [28] Ground 
Type 3

• C3Dsurface-C-TOPO-Outside Curbing: [38] Concrete 
Type 3

• C3Dsurface-C-TOPO-Outside Grading: [28] Ground 
Type 3

• C3Dsurface-C-TOPO-Parking Lot Surface:[39] Asphalt 
Type 4

25.Close the Civil View Explorer.

26.Click  (Zoom Extents All). In the Perspective view, the 
scene displays as shown in Figure 3–10.

Figure 3–10

27.Save your work as MyCivil Base XRef.max.
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3.2 Linking Files

File linking is useful when you are working on a visualization 
project and know that all design decisions have not been made. 
If a source file is likely to change (or you want to make changes 
in the .DWG, .DXF, .FBX, or RVT directly), File Linking might be 
the best way to incorporate this data into the Autodesk 3ds Max 
Design software as the scene can be updated to display those 
changes. You can link files using the Manage Links dialog box 
that can be opened as follows:

• >Import>Link Revit: Links the .RVT files from the 
Autodesk Revit Architecture software.

• >Import>Link FBX: Links the .FBX files that can be 
created in the Autodesk Revit, Autodesk MotionBuilder, 
Autodesk Maya, and Autodesk Mudbox software.

• >Import>Link AutoCAD: Links the .DWG and .DXF files 
from the AutoCAD software.

Autodesk Certification Topics & Objectives
Pro. User

Data Management/Interoperability

• Differentiate common file types and usages

• Use the import feature to import model data

Learning Objectives

• Combine entities from .DWG, .DXF, .FBX, and .RVT files into 
the current Autodesk 3ds Max Design scene.

• Understand how to link AutoCAD DWG/DXF files and 
understand the working of the provided options.

• Understand how to link Generic FBX files and the Autodesk 
Revit RVT/FBX files and understand the working of the 
provided options.

• Create and modify the presets using the respective File Link 
Settings dialog box.
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You need to open the file to link and the Manage Links dialog box 
opens in which you can select the settings. You can also open 

the Manage Links dialog box by expanding , expanding 
References, and selecting Manage Links.

Linking DWG
Files

When linking or importing AutoCAD .DWG or .DXF files, it is 
efficient to combine multiple, related objects together into a 
single Autodesk 3ds Max Design object to control their display 
and visibility. 

• In CAD data files it is common to have large numbers of 
objects since most of these objects can be effectively 
managed by a handful of layer settings and object properties.

• The detail involved when creating a 3D visualization usually 
requires a lot more information, often applied through object 
properties and modifiers. This can make dealing with 
thousands of similar, related entities in the Autodesk 3ds Max 
Design software very cumbersome. For example, a 2D 
architectural AutoCAD floor plan made up of individual line 
segments might be much easier to work with as a single, 
combined spline object. If you are planning to create 3D 
objects from these splines it is necessary to combine them 
into a single line.

When multiple entities are combined into compound Autodesk 
3ds Max Design shapes (2D objects) and meshes (3D objects), 
you can still access and adjust the original geometry in the 
Sub-object level of Modifiers, such as Edit Spline, Edit Mesh, 
and Edit Poly.

Therefore combining individual entities does not mean giving up 
editing control of the original geometry.

Objects or portions of objects can even be detached to form new 
objects, if necessary.

• Modifiers like Edit Spline, Edit Mesh, and Edit Poly can be 
used to edit the imported and linked geometry in addition to 
regularly created splines and primitives in the Autodesk 3ds 
Max Design software.
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Linking FBX
and RVT Files

Autodesk has put a lot of work recently into making the Autodesk 
Revit and Autodesk 3ds Max Design software work better 
together. The Autodesk Revit and Autodesk 3ds Max software 
share mental ray renderer and both the products use the 
Autodesk Material Library materials. 

The .RVT and .FBX file format supports the Autodesk Material 
Library and also supports the import of photometric lights, both 
interior artificial lights and exterior daylight systems. The 
disadvantage is that sometimes the file size can become very 
large and it is impossible to import a project in a single file. You 
can use a section box in the 3D View in the Autodesk Revit 
software to limit the amount of the scene you are exporting at a 
specific time.

Manage Links
Options

The Manage Links dialog box (shown in Figure 3–11) contains 
the following tabs:

Figure 3–11
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Attach Tab

You can open a file (.DWG, .DXF, .FBX, or .RVT) for linking using 

 which opens the Open dialog box. The selected 
filename and its path display in the File drop-down list. If the file 
that you selected is a .RVT file with more than one camera view, 
you are prompted to select a camera view. You can select the 
preset settings in the Preset drop-down list. The Presets listed 
here can be created or modified using the Presets tab. You can 
set the units by selecting them in the Incoming file units 

drop-down list.  is only available with 
.DWG and .DXF file types and enables you to select the layers 

that you want to be included with the drawing file.  
links the selected file with the specified preset settings to the 
current Autodesk 3ds Max Design scene.

Files Tab

The Files tab displays a list of files that are linked to the current 
scene. An icon in front of the filename indicates its current status. 

If the linked file has been modified,  is displayed with the linked 

filename.  indicates that the linked file is unchanged and does 

not have any errors. Highlight a file to make , , 

and  available. 

• : When the original file has been changed, use the 
Reload option to display the changes in the current scene. 

• : Use when you want to remove the link with the 
original file. This option removes all geometry associated with 
the linked file. 

• : Removes the link with the original file, but the 
geometry stays in the current scene, although the link 
between the original file is broken. Changes made to the 
original linked file cannot be reloaded.
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Presets Tab

Many options are available before files are linked to your current 
scene. These options are configured and saved as Presets and 
can be used when linking files at a later stage. Many of these 
options require trial and error to find the most appropriate 
settings. You can link a file and then reload (or detach and relink) 
with different settings until you achieve the required results. If 
you are linking a file for the first time, you should create a new 
preset.

The Presets tab lists all existing presets and contains options for 
creating new presets, modifying existing presets, copying 
existing presets, renaming and deleting them. You need to select 
a preset for the Modify, Copy, Rename, and Delete options to 
be available, as shown in Figure 3–12. If no preset is selected, 
Copy is replaced by New and is the only available option.

Figure 3–12

Depending on the type of preset selected (.RVT, .FBX, or 

.DWG), clicking  opens a specific File Link Settings 
dialog box. This dialog box enables you to define the way you 
want the geometry to be linked, what portions of the file are to be 
modified on Reload, and how the geometry is combined.

File Link
Settings: DWG

Files

In the Manage Links dialog box, in the Presets tab, selecting an 

AutoCAD DWG file preset and clicking  opens the 
File Link Settings: DWG Files dialog box, as shown in 
Figure 3–13.
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Figure 3–13

Basic Tab

The options available in the Basic tab are:

• Weld nearby vertices and Weld threshold: Welding joins 
together vertices of the same object that fall within the weld 
threshold. If the objects are joined by layer, this option 
removes duplicate vertices so that the adjacent 2D objects on 
the same layer are automatically combined into splines. 
Adjacent 3D objects that are welded become faces in a single 
mesh that share common vertices. Welding is essential for 
combining multiple CAD entities into a smaller number of 
Autodesk 3ds Max Design objects. Welding is often 
necessary for the Auto-smooth option to be effective and 
manually adjust smoothing through smoothing groups.

• Auto-smooth adjacent face and Smooth-angle: 
Auto-smooth enables adjacent faces in the same 3D mesh to 
display smooth if the angles of separation between their face 
normals (a directional vector perpendicular to the face) is 
equal to or less than the Smooth-angle. Otherwise the 
adjacent faces have a faceted edge between them. This is 
the same smoothing process used in the Edit Mesh and Edit 
Poly modifiers. You can adjust smoothing later if you still 
encounter smoothing issues after import.

• Orient normals of adjacent faces consistently: This option 
attempts to coordinate the face normals of linked objects. 
This option should be left off by default unless some faces of 
your 3D objects are missing after the link.
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• Cap closed splines: This option automatically assigns an 
Extrude modifier to all closed 2D geometry (e.g., circles and 
closed polylines).

• Texture mapping: Texture mapping is used to locate texture 
maps on objects. The Generate coordinates on-demand 
option links objects without adding any texture mapping at all, 
instead adding the mapping when it is first called for by the 
Autodesk 3ds Max Design software. This option enables a 
faster link but might cause some discrepancies between the 
mapping generated in the Autodesk 3ds Max Design 
software and any mapping that might have been present in 
the original drawing file. The other option, Generate 
coordinates for all objects, adds texture mapping to all 
objects at the time of the link, matching any that might have 
existed in the original drawing file.

• Curve steps: This setting defines the number of segments to 
subdivide each 2D curve segment into if they are later 
extruded in the Autodesk 3ds Max Design software. This 
setting applies to circles, arcs, polyline curves, spines, and 
similar curved objects.

• Maximum surface deviation for 3D solids: This setting 
defines the allowed deviation distance from a parametric 
AutoCAD 3D curve (such as a curved AutoCAD extrusion) 
and the resulting Autodesk 3ds Max Design mesh. The lower 
the value, the more a 3D curve is subdivided. This option is 
necessary because although the AutoCAD software and 
some vertical applications support true 3D curves, the 
Autodesk 3ds Max Design software does not. In the 
Autodesk 3ds Max Design software all 3D curves must be 
segmented, though geometry can appear perfectly smooth if 
it is assigned to appropriate smoothing groups. It is common 
practice to set this value very low, (0.01) when importing work 
with smooth curves.

• Include area options: These options enable you to select 
the type of objects to be brought into the Autodesk 3ds Max 
Design software. Cleared (not selected) object types are 
ignored during the link. Note that the Lights option only 
brings in Lights from AutoCAD drawings pre-2007. If you are 
trying to bring in Lights from the 2009 line of CAD products, 
the Lights do not come in, even if the Lights option is on. The 
exception to this is if you have Sun and Sky checked, a 
daylight system is created based on the information in the 
incoming DWG file from the Autodesk Revit 2009 software.
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Advanced Tab

The Advanced tab (shown in Figure 3–14), controls the import of 
AutoCAD primitives and the effect of scene materials while 
importing.

Figure 3–14

The options available in the Advanced tab are:

• Derive AutoCAD Primitives by: This option controls how 
AutoCAD objects are combined when linked. This setting 
does not apply to some vertical application objects such as 
those in AutoCAD Architecture.

Layer Creates one object for each AutoCAD layer. Each 
AutoCAD block links as a single object called a 
VIZBlock. The Autodesk 3ds Max Design software might 
not translate AutoCAD block materials correctly if a block 
contains objects with different materials applied.

Layer, Blocks 
as Node 
Hierarchy

This option is similar to Layer, but it preserves material 
assignments in linked AutoCAD blocks. It structures 
each as a hierarchy of objects rather than single objects.

Layer, Blocks 
as Node 
Hierarchy, 
Split by 
Material

This option works similarly to the one above but takes 
into account drawings that have more than one material 
applied to objects on the same layer. With this option 
separate hierarchies are created for each material type 
on each layer, to better preserve the AutoCAD material 
assignments. New users should consider using this as 
their default link option.
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• Create helper at drawing origin: This option adds an origin 
point helper at the origin of the current coordinate system. All 
of the linked geometry is part of a hierarchy parented by this 
helper, so all of the linked objects can be repositioned as one 
by transforming the helper.

• Use Extrude modifier to represent thickness: When 
linking 2D AutoCAD objects with a non-zero thickness value, 
these objects translate into the Autodesk 3ds Max Design 
software as a 3D mesh when this option is disabled. When 
enabled, objects translate as 2D objects with a parametric 
extrude modifier. The resulting geometry is the same but 
when this option is enabled the extrusion properties (such as 
height) can be modified after the link or import using the 
modifier stack.

• Create one scene object for each AutoCAD Architecture 
one: With this option off, AutoCAD Architecture (formerly 
ADT) and AutoCAD MEP objects are subdivided into 
separate objects by material. It is recommended to leave this 
option as cleared, since AutoCAD Architecture objects often 
contain more than one material. Linking each AutoCAD 
Architecture object as a single Autodesk 3ds Max Design 
object would require you to configure Multi/Sub-Object 
materials to show different materials on different parts of the 
same object.

• Use scene material definitions: When left as cleared, the 
Autodesk 3ds Max Design software includes the current state 
of any material applied to the linked objects in the AutoCAD 
software. When selected, if the current scene has a material 
with the same exact name as the AutoCAD material, then the 
scene material is used instead.

Entity, Blocks 
as Node 
Hierarchy

This option includes all non-blocks as separate, 
individual objects. Blocks are preserved as hierarchies, 
however, organized by layer.

Color Combines AutoCAD objects by color. All objects of one 
color are joined in as a single object, regardless of layer.

Entity This option does not combine AutoCAD objects at all. 
Instead, each AutoCAD object becomes an individual 
object. The use of this option is discouraged except for 
simple drawing files.

One Object This option combines all AutoCAD objects into a single 
Autodesk 3ds Max Design object. For example, this is 
useful when linking a drawing file that contains many 
thousand AutoCAD 3D faces on different layers that you 
intend to use in the Autodesk 3ds Max Design software.
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• Use scene material assignments on Reload: When left as 
cleared, the Autodesk 3ds Max Design software re-loads the 
current state of any AutoCAD materials present in the 
drawing file when the link is updated. When enabled, the 
Autodesk 3ds Max Design software maintains the current 
state of any materials in the scene file after a link is updated. 
If you intend to adjust linked materials in the Autodesk 3ds 
Max Design software then you should enable this option. If 
you intend to perform your material adjustments in the 
AutoCAD software you should not.

• Selective Reload: Enables you to reload a subset of the 
original file. If you select this option, you can select objects to 
reload by selecting them in the scene or by selecting them 
from a list. If you select Selected in List, and click 

 a list is displayed.

Spline Rendering Tab

The options present in the Spline Rendering tab (shown in 
Figure 3–15), enable linear objects (2D and 3D lines, polylines, 
etc.) to display as extruded 3D objects in the viewports or 
rendering. Normally splines cannot be rendered because they do 
not have surface area to interact with scene lighting. These 
options enable splines to link into the Autodesk 3ds Max Design 
software as 3D linear objects with a cross-sectional radius or a 
rectangular length and width. This provides the surface area for 
rendering.

Figure 3–15
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• If splines are to be rendered with materials then smoothing, 
mapping coordinates, and/or real-world map size are often 
important.

• When enabled, all of the splines linked with this setting are 
renderable, and all have the same cross-section geometry.

• If you want to make only certain 2D objects renderable (or 
want some to render differently than others) you could 
alternately apply a Renderable Spline modifier directly to 
those objects after linking, as shown on the right in 
Figure 3–16. 

Figure 3–16

Hint: Hierarchies and File Linking

Autodesk 3ds Max Design Hierarchies are collections of 
objects linked together into parent/child relationships where 
transforms applied to a parent are automatically passed on to 
its children. Connecting multiple objects in a hierarchical chain 
can enable sophisticated animations in the Autodesk 3ds Max 
Design software, such as the motion of jointed robotic arms.

In the case of the hierarchy file link options, incoming 
AutoCAD blocks are brought into the Autodesk 3ds Max Design 
software as multiple objects so that they can maintain multiple 
material assignments from the AutoCAD software. They display 
together with a Block/Style Parent object, enabling you to 
transform the block as a unit by selecting the parent. The 
parent object itself does not have any geometry and does not 
render. Most modifiers (such as Substitute) must be applied to 
the objects in the hierarchy rather than the parent.
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File Link
Settings: Revit

Files (RVT or
FBX)

In the Manage Links dialog box, in the Presets tab, selecting an 

Autodesk Revit file and clicking  opens the File Link 
Settings: Revit Files (RVT or FBX) dialog box, as shown in 
Figure 3–17. 

Figure 3–17

In the Manage Links dialog box, in the Presets tab, you can also 

select Autodesk FBX (Generic) file preset and click . 
This opens the File Link Settings: FBX Files dialog box, as 
shown in Figure 3–18. This dialog box is similar to the Autodesk 
Revit Files (.RVT and .FBX) without a Geometry area for 
controlling the segments and smoothing the linked geometry.

Figure 3–18
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The options available in the File Link Settings: Revit Files (RVT 
or FBX) dialog box are:

• Combine Entities list: This option enables you to select the 
Autodesk Revit entities that you want to combine, as shown 
in Figure 3–19. For example, if you select By Revit Material, 
all of the entities that have the same material are linked in the 
current Autodesk 3ds Max scene as a single object. It is 
recommended that you combine entities as it reduces the 
number of objects.

Figure 3–19

• Objects area: The selected options in this area are linked 
from the .RVT file to your current scene. If the .RVT file or 
.FBX file contains photometric lights, interior artificial lights, 
cameras, and exterior daylight systems, you can select the 
associated options in the File Link Settings dialog box. While 
linking the daylight system from the .RVT/.FBX file, the 
Autodesk 3ds Max Design software recommends that you 
toggle on the exposure control, as shown in Figure 3–20.

Figure 3–20

• Geometry area: In this area, you can set the number of 
segments for your curved entities and apply auto-smoothing 
to them.

• Materials area: The options in this area enable you to control 
the material definitions and assignment settings. 
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Practice 3b Linking an AutoCAD DWG

Estimated time for 
completion: 20 minutes

In this practice you will link AutoCAD geometry to represent the 
parking lot details, such as pavement markings and other details. 
The 3D markings were created by projecting 2D lines to the 
elevation of a terrain model.

You must set the paths to locate the External files and Xrefs 
used in the practice. If you have not done this already, return to 
the Introduction to Autodesk 3ds Max Design chapter and 
complete Task 1 to Task 3 of the Organizing Folders and 
Working with the Interface practice. You only have to set the 
user paths once.

Task 1 - Link an AutoCAD .DWG File.

If a dialog box opens 
prompting you about a 
File Load: Mismatch, 

click  to 
accept the default 
values.

1. Continue working in the file MyCivil Base Xref.max or open 
Civil Base.max from your Class Files folder.

2. Expand , expand Import, and select Link AutoCAD. In 
the Open dialog box, browse and open the import subfolder 
in your Class Files folder. Select 3D Parking Lot Detail.dwg 

and click .

3. The Manage Links dialog box opens with the path and the 
filename displayed, as shown Figure 3–21.

Figure 3–21

Learning Objectives

• Create a preset to link an AutoCAD .DWG file and reposition 
the file using the Helper object.

• Revise the link settings and reload the linked file.



Autodesk 3ds Max Design 2015 Fundamentals

3–26 © 2014, ASCENT - Center for Technical Knowledge®

If no preset is selected, 

only  is 
available.

4. You will configure and save a link preset before linking the 

drawing file. Select the Presets tab and click  to 
create a new preset.

5. In the New Settings Preset dialog box, set New Name as 
AutoCAD – Derive by Layer. Note that the Format is 

selected as AutoCAD Drawings. Click . 

6. Now you will modify the preset settings. In the Manage Links 
dialog box, select the newly created preset, AutoCAD – 
Derive by Layer, as shown in Figure 3–22. Note that the 
Modify, Copy, Rename, and Delete options are now 

available. Click .

 
Figure 3–22

The Create Helper at 
drawing origin option 
adds a helper object at 
the origin of the linked 
file.

7. In the File Link Settings: DWG Files dialog box, in the Basic 
tab, set the link options, as shown on the left in Figure 3–23. 
Select the Advanced tab. Select Create helper at drawing 
origin and leave all of the other options as their defaults, as 
shown on the right in Figure 3–23.
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Figure 3–23

8. Select the Spline Rendering tab and verify that the link 
options are set as shown in Figure 3–24. 

Figure 3–24

9. Click .
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10. In the Manage Links dialog box, select the Attach tab. Set 
Preset to AutoCAD – Derive by Layer, as shown in 

Figure 3–25. Click .

Figure 3–25

11. In the Select Layers dialog box, select Select from list. 
Select 0 and DEFPOINTS to clear them, leaving rest of the 

layers selected, as shown in Figure 3–26. Click .

Figure 3–26

12. In the Manage Links dialog box, click . 
Note that the parking lot details have been added to the 
scene, but are located far away from the origin, as shown in 
the Top viewport in Figure 3–27. Close the Manage Links 
dialog box.
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Figure 3–27

Task 2 - Relocate the Linked Geometry.

You might need to start 
Civil View, if it is not set 
to open automatically.

1. You need to move the parking lot details by the global shift 
values in Civil View. In the Menu Bar, select Civil View>Civil 
View>Civil View Explorer.

2. In the Civil View Explorer, select Scene Settings, as shown 
on the left in Figure 3–28. In the Scene Settings rollout, note 
the Global Import Shift values for X Shift and Y Shift (-9901), 
as shown on the right in Figure 3–28. You will use these 
values to move the linked .DWG file. Close the Civil View 
Explorer.

Figure 3–28

3. In the Main toolbar, click  (Select and Move).
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4. In the Scene Explorer, select the helper object (  displayed 
next to name) 3D Parking Lot Detail.dwg, or directly in the 
Top viewport, select the helper object (the User Coordinate 
System icon) for the linked .DWG file, which is located at the 
origin, as shown in Figure 3–29. Selecting the helper objects 
selects all of the objects in the linked file and enables you to 
modify them together.

Figure 3–29

5. In the Status Bar, verify that  (Absolute Mode Transform) 
is displayed. In the X edit box, enter -9901’0". Click in the Y 
edit box, enter -9901’0", and press <Enter>, as shown in 
Figure 3–30.

Figure 3–30

6. Click  (Zoom Extents All). Note how the parking lot details 
are placed exactly on the parking lot surface.

7. In the Perspective viewport, use  (Zoom) and  (Orbit) 
to zoom into the Parking lot area and tilt the view to display 
the area below the surfaces, as shown in Figure 3–31. Note 
that in addition to the 3D pavement markings, 2D line 
markings are imported through the link. A reload of this file 
would enable you to revise the link settings and/or to update 
the scene if the drawing is modified.

Figure 3–31
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Task 3 - Revise the Link Settings.

In the Files tab, if the 
linked file has been 

modified,  and the 
linked filename are 
displayed. You can use 

 to update 

the file in the scene.  
indicates that the linked 
file has not changed and 
does not have any 
errors. In this case, use 

 to revise 
the link settings.

1. Click >References>Manage Links to open the Manage 
Links dialog box.

2. In the Manage Links dialog box, select the Files tab and note 

that the linked file displays , indicating that the file has not 
changed. Verify that Show Reload options is selected, and 

click . (  removes a linked drawing 

from the scene.  inserts the drawing as is and 
removes the connection.)

3. The File Link Settings: DWG Files dialog box opens. In the 

Advanced tab, click . Click on all of 
the 2D layers, (C-MARK-WHITE-2D, C-MARK-YELLOW-2D, 
and the two LIGHTPOLE layers) to clear their selection, as 
shown in Figure 3–32.

Figure 3–32

4. Click  twice to close both dialog boxes. The 2D 
linework should no longer display, keeping the scene smaller. 

Close the Manage Links dialog box by clicking .

5. Save your work as MyCivil Base.max.
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Practice 3c Linking and Reloading Autodesk 
Revit File

Estimated time for 
completion: 20 minutes

In this practice you will link a .RVT file and reload a modified 
version of the file. 

You must set the paths to locate the External files and Xrefs 
used in the practice. If you have not done this already, return to 
the Introduction to Autodesk 3ds Max Design chapter and 
complete Task 1 to Task 3 of the Organizing Folders and 
Working with the Interface practice. You only have to set the 
user paths once.

Task 1 - Link an Autodesk Revit (.RVT) file.

If a dialog box opens 
prompting you about a 
File Load: Mismatch, 

click  to 
accept the default 
values.

1. Continue working in the file MyCivil Base.max or open Civil 
Base Link.max from your Class Files folder.

2. Expand , expand Import, and select Link Revit.

3. In the Open dialog box, in the import subfolder of your Class 

Files folder, select Revit Building-1.rvt and click . 

If there are multiple 
cameras in the .RVT 
file, the Select Revit 
View dialog box opens.

4. The Link Revit View dialog box opens indicating the progress 
of the file as it is loading (It might take a few minutes to load 
the file). Once loaded, the Select Revit View dialog box 
opens as shown in Figure 3–33. 

Figure 3–33

Learning Objectives

• Link an Autodesk Revit file to the current scene.

• Reposition the Autodesk Revit file using the Helper object.

• Incorporate the changes made to the original Autodesk Revit 
file into the current scene using Reload.
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5. You need to select one camera view. Select Front Exterior 

3D View and click .

6. In the Manage Links dialog box, select the Presets tab.

7. Click  to create a new preset. In the New Settings 
Preset dialog box, set New Name to Revit Preset and 

Format to Autodesk Revit (*.rvt,*.fbx). Click .

8. Select Revit Preset to highlight it and click .

The Create Helper at 
Model Origin option 
adds a helper object at 
the origin of the linked 
file. Selecting and 
applying transforms 
(move, rotate, or scale) 
to the helper object 
applies the transform to 
the linked geometry 
together.

9. In the File Link Settings dialog box, in the Combine Entities 
drop-down list select By Revit Category. In the Objects area, 
clear Lights and Daylight System. Select Create Helper at 
Model Origin and Cameras. In the Geometry area, set 
Curved Objects Detail to 6. Verify that both Keep 3ds Max 
scene materials parameters on reload and Keep 3ds Max 
scene material assignments on reload are cleared, as 

shown in Figure 3–34. Click .

Figure 3–34

10.Select the Attach tab. Expand the Preset drop-down list and 
select Revit Preset.
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11. Click . (It might take a few minutes to load 
the file). Note that the Autodesk Revit building and camera 
are loaded at the 0,0,0 location in the viewports.

12.Close the Manage Links dialog box by clicking . 

If your Scene Explorer is 
not open, select 
Tools>Saved Scene 
Explorers>
Workspace: Default.

13. In the Scene Explorer toolbar, click  (Display None) to 

clear any selection group and click  (Display Helpers). 
Locate and select Revit Building-1.rvt, as shown in 
Figure 3–35.

Figure 3–35

14.Right-click on the Top viewport to make it active (if not 
already active) and to maintain the selection. In the Main 

toolbar, click  (Select and Move). The Transform gizmo is 
displayed at the helper location, which is the origin of the 
linked Autodesk Revit file.

The position of the 
building pad from the 
origin has been 
calculated.

15. In the Status Bar, verify that  (Absolute Mode Transform) 
is displayed. In the X edit box, enter 800’0". Click in the Y 
edit box and enter 382’0". Click in the Z edit box, enter 
154’6", and press <Enter>, as shown in Figure 3–36.

Figure 3–36

16.Click  (Zoom Extents All). Note how the building is placed 
on the building pad.

Grid has been hidden 
for clarity. Press <G>.

17. In the Front viewport, use  (Zoom Region) and create a 
rectangular window around the building to only zoom into the 
building. Select the Wireframe Visual Style label and select 
Realistic. The building displays as shown in Figure 3–37.
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Figure 3–37

18. In the Perspective viewport, use  (Zoom) and  (Orbit) 
to zoom into the building and parking lot area, as shown in 
Figure 3–39.

19. In the Left viewport, select the Wireframe Visual Style label 
and select Shaded. Select the Left Point of View label, and 
select Camera>3D View: Front Exterior 3D View, as shown 
in Figure 3–38. The camera view that was selected when the 
Autodesk Revit file was linked displays.

Figure 3–38

20.Use Pan to display the complete building in the Left viewport, 
as shown in Figure 3–39.

Figure 3–39
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Task 2 - Reload the variation of the .RVT file.

Changes can be made in the source file and reloaded directly 
into the linked file in the Autodesk 3ds Max software. A variation 
to the .RVT linked file (windows have been added) has been 
included in your Class Files\import folder.

1. In Windows Explorer, open the import folder of your Class 
Files folder (C:\Autodesk 3ds Max Design Fundamentals 
Class Files\ import).

2. Select Revit Building-1.rvt, right-click and select Rename. 

3. Rename the file as Revit Building-1_ORIGINAL.rvt.

4. Select Revit Building-2.rvt, right-click and select Copy. Paste 
a copy of this file into the same directory. Right-click on the 
copied file, select Rename, and rename the file as Revit 
Building-1.rvt. This must be the same name as the original 
file that was linked to indicate that the original linked file has 
changed.

5. Return to the Autodesk 3ds Max Design software. Click 

>References>Manage Links to open the Manage Links 
dialog box.

 indicates that the 
linked file has not 
changed and does not 

have any errors.  
indicates that the linked 
file has been modified.

6. In the Manage Links dialog box, select the Files tab. Note 

that  is displayed in front of the .RVT filename (as shown in 
Figure 3–40), indicating that changes have been made to the 
original linked file.

Figure 3–40

7. Select the complete path of Revit Building -1.rvt, if not 

already selected and click . The Link Revit View 
dialog box displays the progress of the file load.
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8. In the File Link Settings dialog box, in the Materials area, 
select Keep 3ds Max scene material assignments on 
reload to keep the materials that have been applied in the 

Autodesk 3ds Max software. Click . The scene is 
refreshed with the new changes. 

9. In the Manage Links dialog box, in the Files tab, the icon has 

changed to , as shown in Figure 3–41. This indicates that 
there are no differences between the original file and the 
linked file.

Figure 3–41

10.Close the Manage Links dialog box.

11. In the viewports, the modified building is displayed. Note that 
more windows have been added to the building, as shown in 
Figure 3–42.

Figure 3–42

12.Save the file as MyCivil Base Link.max.
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3.3 References

External
References

(XRef)

Autodesk 3ds Max Design Scene files can also reference data 

from other scene files by expanding , expanding 

References, and selecting XRef Objects and expanding , 
expanding References, and selecting XRef Scene. The XREF 
data remains linked to the source (.MAX) scene file so that 
changes in the source file can be reflected in any scene that 
contains the XREF.

• External References are useful to break up large projects into 
more manageable pieces, permit more than one person to 
work on the same project at the same time in separate files, 
and to enable the same core scene geometry to be used in 
multiple files with different lighting conditions and/or 
animations.

• XRef Scenes bring in the entire scene. All of the XREF 
objects are non-selectable and cannot be modified.

• XRef Objects enable you to select individual objects (or all) 
from an XREF scene. These objects remain selectable and 
modifiable in the XREF scene file.

• You can snap to XREF and use XREF objects with AutoGrid. 
You can also use XREF objects as alignment targets and you 
can select an XREF object’s coordinate system for object 
transformation. XREF support parameter wiring and you can 
XREF the controllers.

• In the Autodesk 3ds Max Design software, a referenced 
.DWG, .FBX, .DXF, or .RVT file is a linked file and not an 
XREF. An Autodesk 3ds Max Design XREF is a reference to 
the data in another .MAX scene file. Objects in scenes 
(.MAX) are imported into other . MAX scenes using the 
Merge option.

Learning Objectives

• Incorporate objects or other scene files into the current scene 
by externally referencing them.

• Manage data using the asset tracking systems.
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Data
Management

and Asset
Tracking 

In addition to merging and externally referencing other scene file 
geometry, the Autodesk 3ds Max Design software also enables 
you to manage your data through Data Management (DM) 
solutions, which are also referred to as Asset Tracking Systems 
(ATSs).

• DM solutions such as the Autodesk® Vault software enables 
you to store scene files and any supporting data (like material 
maps) in a single database repository.

• These systems can be accessed simultaneously by multiple 
users who might be assigned different rights based on their 
project responsibilities. Data can be checked out for editing 
by one individual at a time while still being referenced by 
other users. Users can see who is editing which portion of the 
project at any time.

• By centralizing the files in a DM system it is much easier to 
adjust paths for external files like image maps.

• Data files can be versioned through DM solutions, so that the 
older versions of files can be readily accessed, if needed.

• Asset Tracking is an important application for users working 
on complex projects in a multi-user environment. Working 
with these sophisticated solutions places their use outside 
the scope of an introductory-level course. For more 
information see Asset Tracking in the Autodesk 3ds Max 
Design Help files. Asset Tracking is available by expanding 

, expanding References, and selecting Asset Tracking.
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Practice 3d XRef and Merge Objects

Estimated time for 
completion: 15 minutes

In this practice create a new scene file that will contain linked 
AutoCAD objects and XRef objects from the Civil Base scene. 

You must set the paths to locate the External files and Xrefs 
used in the practice. If you have not done this already, return to 
the Introduction to Autodesk 3ds Max Design chapter and 
complete Task 1 to Task 3 of the Organizing Folders and 
Working with the Interface practice. You only have to set the 
user paths once.

Task 1 - Assemble the Data.

If an unsaved scene is 
open, you need to save 
or discard the changes 
to the scene.

1. Expand  and select Reset. Click  to reset the 
scene.

2. For this scene. set the System Unit Scale to Inches. Select 
Customize>Units Setup. In the dialog box, verify that 
Display Unit Scale is set to US Standard, Feet w/Fractional 
Inches, Default Units is set to Inches, and Lighting Units to 

American. Click . In the System 
Unit Setup dialog box, set System Unit Scale to Inches. Click 

 in both the dialog boxes.

3. Expand , expand References, and select Manage 

Links. In the Attach tab, click . In your Class Files 
folder>
import subfolder, select Exterior AutoCAD Architectural 

Model.dwg. Click .

4. In the Preset drop-down list, select AutoCAD – Derive by 

Layer and click . Once the file has been 

loaded, close the dialog box by clicking .

Learning Objectives

• Link an AutoCAD .DWG file to the current scene.

• Incorporate objects from another scene file into the current 
scene using XREF.

• Merge objects into the current scene file.
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• The AutoCAD Architectural objects were not joined 
together by layer. Each was subdivided by material type 
into different objects. Materials previously assigned in 
AutoCAD Architecture were preserved on these separate 
objects.

5. Click  (Maximize Viewport Toggle) or use <Alt>+<W> to 
display the four viewport view.

6. Click  (Zoom Extents All) to display all of the objects in all 
of the viewports.

7. In the Front viewport, select all of the objects by creating a 
window around the objects. In the Main toolbar, in the Named 
Selection Sets field, enter exterior AutoCAD Architectural 
building, as shown in Figure 3–43 and press <Enter>.

Figure 3–43

You select objects to 
XREF rather than the 
entire scene because 
XREF scene objects 
cannot be selected or 
modified.

8. Expand , expand References, and select XRef Objects. 

In the XRef Objects dialog box, click  (Create XRef 
Record from File) as shown in Figure 3–44.

Figure 3–44

9. In the Open File dialog box, select Parking Lot Detail.max 

(Class Files folder>import subfolder) and click .
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10. In the XRef Merge dialog box, click  (at the bottom of 
the dialog box) to select all of the objects, as shown in 

Figure 3–45. Click .

Figure 3–45

11. The Duplicate Material Name dialog box opens prompting 
you that there is an incoming material with the same name as 
an existing scene material. Select Apply to All Duplicates, 
as shown in Figure 3–46, to keep both materials and click 

.

Figure 3–46



Assembling Project Files

© 2014, ASCENT - Center for Technical Knowledge® 3–43

12. In the XRef Objects dialog box, note that the .MAX filename 

is displayed. Close the dialog box by clicking .

13.Click  (Zoom Extents All). Note that the Civil Base objects 
are located far from the origin. This is a coordinate system 
discrepancy and not a scale issue. It is common for 
Architectural drawings to be based in a different coordinate 
system and scale than the accompanying Civil/Survey 
drawings. 

Task 2 - Coordinate the Data.

In this task you will relocate the Civil Base in the Architectural 
Data. To line up the data accurately you will need the exact 
coordinate translation and rotation. You can measure ahead of 
time in programs, such as AutoCAD by comparing the 
coordinates of points common to both files.

Alternatively, you can 
use the Scene Explorer 
to select all the XRef 
objects..

1. In the Main toolbar, click  (Select by Name). In the Select 

From Scene dialog box, click  (Display None) and click

 (Display Object XRefs). Select all of the XRef objects in 
the list (use <Ctrl>+<A> or use the cursor) and click 

.

2. With only the XRef objects selected, select Group>Group. 

3. In the Group dialog box, set the Group name to be Site XRef 

and click .

4. In the Main toolbar, click  (Select and Move). In the 
Reference Coordinate System, select World, as shown in 

Figure 3–47 and click  (Use Transform Coordinate 
Center).

Figure 3–47

5. In the Status Bar, verify that  (Absolute Mode) is displayed 
(which means it is enabled).
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6. In the Transform Type-in area, set X: to -197’4”, Y: to -30’0”, 
and Z: to -4’11”, as shown in Figure 3–48, and press 
<Enter>. (The translation coordinates have already been 
measured in AutoCAD.)

Figure 3–48

7. In the Main toolbar, click  (Select Object) to exit the 
Move transform operation.

8. Click  (Zoom Extents All). In the Perspective viewport, use 

 (Zoom),  (Orbit), and Pan to zoom into the parking lot 
and building area (as shown in Figure 3–49), and verify the 
building is located on the building pad. Even though the 
XREF had a different Unit Scale (feet), it scaled correctly to 
the current scene (in inches).

Figure 3–49

9. Save your work as MyArchitectural Scene.max.
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Task 3 - Merging Objects.

In this task you will merge the light poles. 

1. Expand >Import>Merge. In the Merge File dialog box, 
select Light Poles for Project1.max from your Class 

Files\scenes folder. Click . 

2. In the Merge dialog box, click  (bottom of the dialog 

box) to select all of the objects and click .

 enables 
both objects to have the 
same name, 

 ignores 
the incoming object, and 

 removes 
the original object.

3. The Duplicate Name dialog box opens, prompting you that an 
object with the same name already exists in the scene. Select 

Apply to all Duplicates and click . 

4. The light poles are displayed in the scene, as shown in 
Figure 3–50.

Figure 3–50

5. Save your work.
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Chapter Review Questions

1. The following file types can be linked to the current Autodesk 
3ds Max Design scene:

a. .DWG, .OBJ, .APF, .FBX

b. .DWG, .DXF, .FBX, .RVT

c. .DWG, .DXF, .MAX, .RVT

d. .DWG, .OBJ, .FBX, .RVT

2. In the Manage Links dialog box, in the Files tab, which of the 
following options do you use to remove the link with the 
original linked file but maintain its geometry in the current 
scene?

a.

b.

c.

3. Which command do you use to combine objects from a saved 
Autodesk 3ds Max Design scene (.MAX file) into your current 
.MAX scene?

a. .Import

b. .Link

c. .Open

d. .Merge

4. While linking Autodesk Revit files in the current Autodesk 3ds 
Max scene, which of the following options are provided in the 
Combine Entities List? (Select all that apply.)

a. By Revit Material

b. By Revit Layer

c. As One Object

d. By Revit Camera
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5. When an entire .MAX scene is brought into the current scene 
using XREF Scenes, the XREF objects are selectable but 
cannot be modified.

a. True

b. False
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Command Summary

Button Command Location
Absolute 
Mode

• Status Bar

N/A Asset 
Tracking

• Application Menu: References

N/A Import • Application Menu: Import

N/A Link AutoCAD • Application Menu: Import

N/A Link FBX • Application Menu: Import

N/A Link Revit • Application Menu: Import

N/A Manage Links • Application Menu: References

N/A Merge • Application Menu: Import

Select by 
Name

• Main toolbar

Select Object • Main toolbar

Use 
Transform 
Coordinate 
Center

• Main toolbar

N/A XRef Objects • Application Menu: References

N/A XRef Scene • Application Menu: References




